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Q.1 Select the most appropriate ANTONYM of the underlined word in the given sentence.

A calm mind precedes excellence, as it clears the intellect and enhances actions with
brilliance.

Ans A. Elevates

B. Upgrades

C. Detracts

D. Augments

Question Type : MCQ

Question ID : 630680684523

Option 1 ID : 6306802680751

Option 2 ID : 6306802680753

Option 3 ID : 6306802680752

Option 4 ID : 6306802680750

Status : Answered

Chosen Option : C

Marks : 1

Q.2 Select the most appropriate adjective to fill in the blank.

The painting was so __________ that everyone in the gallery stopped to admire it.

Ans A. dull

B. mesmerising

C. boring

D. tedious

Question Type : MCQ

Question ID : 6306801044912

Option 1 ID : 6306804101789

Option 2 ID : 6306804101790

Option 3 ID : 6306804101788

Option 4 ID : 6306804101791

Status : Answered

Chosen Option : B

Marks : 1
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Q.3 Select the most appropriate option to substitute the idiom/phrase highlighted in bold in the
given sentence.

The manager threw cold water over the project proposal that Ms. Smitha had submitted.

Ans A. heartened

B. encouraged

C. reassured

D. discouraged

Question Type : MCQ

Question ID : 630680805559

Option 1 ID : 6306803155900

Option 2 ID : 6306803155898

Option 3 ID : 6306803155897

Option 4 ID : 6306803155899

Status : Answered

Chosen Option : D

Marks : 1

Q.4 Select the most appropriate meaning of the given proverb.

Old habits die hard.

Ans A. It is difficult to change established habits.

B. Habits never change.

C. Old people have strong habits.

D. Young people have weaker habits.

Question Type : MCQ

Question ID : 6306801046004

Option 1 ID : 6306804106101

Option 2 ID : 6306804106102

Option 3 ID : 6306804106100

Option 4 ID : 6306804106103

Status : Answered

Chosen Option : A

Marks : 1

Q.5 Select the most appropriate homonym to fill in the blank.

Sherlin was so tired that she could barely keep her ____open.

Ans A. ice

B. I

C. eyes

D. aye

Question Type : MCQ

Question ID : 6306801045388

Option 1 ID : 6306804103679

Option 2 ID : 6306804103676

Option 3 ID : 6306804103677

Option 4 ID : 6306804103678

Status : Answered

Chosen Option : C

Marks : 1



Q.6 Select the most appropriate option to substitute the underlined word segment in the given
sentence.

Pakshikha was delighted to discover that, among all the guests, the person was only she
who knew the special significance of the event.

Ans A. she was the person only

B. was she the person alone

C. was she person only

D. she was the only person

Question Type : MCQ

Question ID : 6306801057216

Option 1 ID : 6306804151275

Option 2 ID : 6306804151278

Option 3 ID : 6306804151277

Option 4 ID : 6306804151276

Status : Answered

Chosen Option : D

Marks : 1

Q.7 Select the most appropriate option to substitute the underlined word segment in the given
sentence.

A cool breeze drifted into the room from through the opened window, carrying the fresh
scent of blooming flowers.

Ans A. through window opened

B. through the openly window

C. through the open window

D. through window the opened

Question Type : MCQ

Question ID : 6306801057232

Option 1 ID : 6306804151339

Option 2 ID : 6306804151342

Option 3 ID : 6306804151341

Option 4 ID : 6306804151340

Status : Answered

Chosen Option : A

Marks : -0.25

Q.8 Select the most appropriate homonym to fill in the blank.

The legal advisor gave the client __________ on the civil matter.

Ans A. consul

B. console

C. counsel

D. council

Question Type : MCQ

Question ID : 6306801046222

Option 1 ID : 6306804106984

Option 2 ID : 6306804106985

Option 3 ID : 6306804106983

Option 4 ID : 6306804106982

Status : Answered

Chosen Option : B

Marks : -0.25



Q.9 Select the most appropriate synonym of the given word.

Inquisitive

Ans A. Indifferent

B. Curious

C. Uninterested

D. Sceptical

Question Type : MCQ

Question ID : 630680805360

Option 1 ID : 6306803155137

Option 2 ID : 6306803155140

Option 3 ID : 6306803155138

Option 4 ID : 6306803155139

Status : Answered

Chosen Option : A

Marks : -0.25

Q.10 Select the most appropriate option to fill in the blank.

By next year, they _____ their new house.

Ans A. will have built

B. build

C. building

D. built

Question Type : MCQ

Question ID : 630680733751

Option 1 ID : 6306802875827

Option 2 ID : 6306802875828

Option 3 ID : 6306802875829

Option 4 ID : 6306802875830

Status : Answered

Chosen Option : A

Marks : 1

Q.11 The following sentence has been split into segments. One of them may contain a spelling
error. Select the segment that contains the spelling error from the given options. If there is
no error, select 'No error' as your answer.

Older people are more susceptible / to disorders, especially when / they already suffer from
ill-health.

Ans A. they already suffer from ill-health.

B. No error

C. Older people are more susceptible

D. to disorders, especially when

Question Type : MCQ

Question ID : 630680744636

Option 1 ID : 6306802918756

Option 2 ID : 6306802918757

Option 3 ID : 6306802918754

Option 4 ID : 6306802918755

Status : Answered

Chosen Option : D

Marks : -0.25



Q.12 Select the most appropriate option to fill in the blank.

After the lengthy trekking, we finally reached at _____ mountain peak.

Ans A. a

B. an

C. the

D. No article needed.

Question Type : MCQ

Question ID : 6306801042907

Option 1 ID : 6306804093813

Option 2 ID : 6306804093814

Option 3 ID : 6306804093815

Option 4 ID : 6306804093816

Status : Answered

Chosen Option : C

Marks : 1

Q.13 Select the correct spelling of the underlined word in the given sentence.

Our custombers are satisfied with our product.

Ans A. customiers

B. costmers

C. costomers

D. customers

Question Type : MCQ

Question ID : 630680736282

Option 1 ID : 6306802885815

Option 2 ID : 6306802885813

Option 3 ID : 6306802885814

Option 4 ID : 6306802885812

Status : Answered

Chosen Option : D

Marks : 1

Q.14 Select the INCORRECTLY spelt word from among the underlined words in the given
sentence.

With a delicate touch, he gently wiped away her tears using a lacy handkerchief that was
embroideered with love.

Ans A. handkerchief

B. gently

C. embroideered

D. delicate

Question Type : MCQ

Question ID : 630680561152

Option 1 ID : 6306802193571

Option 2 ID : 6306802193570

Option 3 ID : 6306802193572

Option 4 ID : 6306802193569

Status : Not Answered

Chosen Option : --

Marks : 0



Q.15 Select the most appropriate proverb that would fit the given situation.

People who are shy and quiet are often very intelligent and interesting.

Ans A. Still waters run deep

B. Silence means consent

C. Speech is silver but silence is golden

D. Sow the wind and reap the whirlwind

Question Type : MCQ

Question ID : 630680764704

Option 1 ID : 6306802997345

Option 2 ID : 6306802997346

Option 3 ID : 6306802997344

Option 4 ID : 6306802997343

Status : Answered

Chosen Option : A

Marks : 1

Q.16 Select the most appropriate ANTONYM of the given word.

Inspire

Ans A. Discourage

B. Ignite

C. Motivate

D. Encourage

Question Type : MCQ

Question ID : 630680753610

Option 1 ID : 6306802953633

Option 2 ID : 6306802953636

Option 3 ID : 6306802953634

Option 4 ID : 6306802953635

Status : Answered

Chosen Option : A

Marks : 1

Q.17 Select the most appropriate meaning of the given idiom.

Under the weather

Ans A. Feeling sick or unwell

B. Being outside in the rain

C. Feeling happy

D. Being depressed

Question Type : MCQ

Question ID : 6306801046134

Option 1 ID : 6306804106624

Option 2 ID : 6306804106626

Option 3 ID : 6306804106627

Option 4 ID : 6306804106625

Status : Answered

Chosen Option : D

Marks : -0.25



Q.18 Select the most appropriate ANTONYM of the underlined word.

Reading books gives bliss.

Ans A. grace

B. pleasure

C. Expansion

D. misery

Question Type : MCQ

Question ID : 630680685681

Option 1 ID : 6306802685270

Option 2 ID : 6306802685269

Option 3 ID : 6306802685271

Option 4 ID : 6306802685268

Status : Answered

Chosen Option : D

Marks : 1

Q.19 Select the option that expresses the given sentence in direct speech.

She explained that she wouldn't be able to attend the meeting.

Ans A. She said, “I wouldn't be able to attend the meeting.”

B. She says, “She won't be able to attend the meeting.”

C. She said, “I won't be able to attend the meeting.”

D. She said, “He wouldn't be able to attend the meeting.”

Question Type : MCQ

Question ID : 630680514252

Option 1 ID : 6306802009635

Option 2 ID : 6306802009634

Option 3 ID : 6306802009633

Option 4 ID : 6306802009636

Status : Answered

Chosen Option : B

Marks : -0.25

Q.20 Select the most appropriate synonym of the given word.

Conduct

Ans A. Establish

B. Manage

C. Observe

D. Construct

Question Type : MCQ

Question ID : 630680745631

Option 1 ID : 6306802922702

Option 2 ID : 6306802922699

Option 3 ID : 6306802922700

Option 4 ID : 6306802922701

Status : Answered

Chosen Option : A

Marks : -0.25



Q.21 Select the most appropriate option to fill in the blank.

The professor's ____________ approach to teaching, focusing on
minute details and strict rules, often frustrated students who
preferred a broader understanding of the subject.

Ans A. fulgent

B. flagrant

C. pedantic

D. diligent

Question Type : MCQ

Question ID : 6306801056008

Option 1 ID : 6306804146544

Option 2 ID : 6306804146542

Option 3 ID : 6306804146545

Option 4 ID : 6306804146543

Status : Answered

Chosen Option : C

Marks : 1

Q.22 Select the option that expresses the given sentence in reported speech.

'We must reach the school by noon', said the mother.

Ans A. The mother said that they must reach the school by the following noon.

B. The mother said that they could reach the school by noon.

C. The mother said that they must have reached the school by noon.

D. The mother said that they must reach the school by noon.

Question Type : MCQ

Question ID : 630680721851

Option 1 ID : 6306802828696

Option 2 ID : 6306802828695

Option 3 ID : 6306802828694

Option 4 ID : 6306802828697

Status : Answered

Chosen Option : A

Marks : -0.25

Q.23 Select the most appropriate idiom to substitute the underlined segment in the given
sentence.

The bank robbers were well-equipped.

Ans A. armed to the teeth

B. on a flying visit

C. a small fry

D. following red tapism

Question Type : MCQ

Question ID : 630680805883

Option 1 ID : 6306803157184

Option 2 ID : 6306803157187

Option 3 ID : 6306803157185

Option 4 ID : 6306803157186

Status : Not Answered

Chosen Option : --

Marks : 0



Q.24 Select the most appropriate option to fill in the blank. If no article is needed, select ‘No
article required’.

Artificial intelligence has changed ______ way we communicate.

Ans A. the

B. an

C. No article required

D. a

Question Type : MCQ

Question ID : 6306801042697

Option 1 ID : 6306804092979

Option 2 ID : 6306804092978

Option 3 ID : 6306804092980

Option 4 ID : 6306804092977

Status : Answered

Chosen Option : A

Marks : 1

Q.25 Select the most appropriate option to fill in the blank.

Sumita’s story of overcoming challenges and achieving her dreams was truly __________ to
everyone who heard it.

Ans A. boring

B. inspirational

C. tiring

D. aspiring

Question Type : MCQ

Question ID : 6306801047090

Option 1 ID : 6306804110476

Option 2 ID : 6306804110475

Option 3 ID : 6306804110477

Option 4 ID : 6306804110474

Status : Answered

Chosen Option : B

Marks : 1



Comprehension:

Read the given passage and answer the questions that follow.

Have you ever said "I hate you" to someone? What about using the 'h-word' in a casual
conversation, like "I hate broccoli"? What are you really feeling when you say that you hate
something or someone?

The Merriam-Webster dictionary describes the word 'hate' as an 'intense hostility and aversion
usually deriving from fear, anger or sense of injury'. All over the world, researchers are
studying hate from disciplines like education, history, law, leadership, psychology, sociology
and many others.

If you had a scary experience with thunderstorms, you might say that you hate
thunderstorms. Maybe you have gotten very angry at something that happened at a particular
place, so now you say you hate going there. Maybe someone said something hurtful to you,
so you say you hate that person.

Understanding hate as an emotional response can help you recognise your feelings about
something or someone and be curious about where those feelings are coming from. This
awareness will give you time to gather more information and imagine the other person’s
perspective.

SubQuestion No : 26

Q.26 According to the Merriam-Webster dictionary, how is 'hate' described?

Ans A. An intense affection and attraction that is triggered instantly

B. An intense hostility and aversion usually deriving from fear, anger or sense of injury

C. A casual indifference and lack of concern towards anyone

D. A mild dislike and avoidance on meeting certain people

Question Type : MCQ

Question ID : 630680796719

Option 1 ID : 6306803121848

Option 2 ID : 6306803121850

Option 3 ID : 6306803121851

Option 4 ID : 6306803121849

Status : Answered

Chosen Option : B

Marks : 1



Comprehension:

Read the given passage and answer the questions that follow.

Have you ever said "I hate you" to someone? What about using the 'h-word' in a casual
conversation, like "I hate broccoli"? What are you really feeling when you say that you hate
something or someone?

The Merriam-Webster dictionary describes the word 'hate' as an 'intense hostility and aversion
usually deriving from fear, anger or sense of injury'. All over the world, researchers are
studying hate from disciplines like education, history, law, leadership, psychology, sociology
and many others.

If you had a scary experience with thunderstorms, you might say that you hate
thunderstorms. Maybe you have gotten very angry at something that happened at a particular
place, so now you say you hate going there. Maybe someone said something hurtful to you,
so you say you hate that person.

Understanding hate as an emotional response can help you recognise your feelings about
something or someone and be curious about where those feelings are coming from. This
awareness will give you time to gather more information and imagine the other person’s
perspective.

SubQuestion No : 27

Q.27 What can be inferred about the role of researchers in studying hate?

Ans A. They study hate from a variety of academic disciplines to understand it better.

B. They ignore the historical context of hate.

C. They focus solely on the negative impacts of hate.

D. They primarily work on methods to eliminate hate from society.

Question Type : MCQ

Question ID : 630680796721

Option 1 ID : 6306803121857

Option 2 ID : 6306803121859

Option 3 ID : 6306803121856

Option 4 ID : 6306803121858

Status : Answered

Chosen Option : A

Marks : 1



Comprehension:

Read the given passage and answer the questions that follow.

Have you ever said "I hate you" to someone? What about using the 'h-word' in a casual
conversation, like "I hate broccoli"? What are you really feeling when you say that you hate
something or someone?

The Merriam-Webster dictionary describes the word 'hate' as an 'intense hostility and aversion
usually deriving from fear, anger or sense of injury'. All over the world, researchers are
studying hate from disciplines like education, history, law, leadership, psychology, sociology
and many others.

If you had a scary experience with thunderstorms, you might say that you hate
thunderstorms. Maybe you have gotten very angry at something that happened at a particular
place, so now you say you hate going there. Maybe someone said something hurtful to you,
so you say you hate that person.

Understanding hate as an emotional response can help you recognise your feelings about
something or someone and be curious about where those feelings are coming from. This
awareness will give you time to gather more information and imagine the other person’s
perspective.

SubQuestion No : 28

Q.28 What does the word 'aversion' mean in the passage?

Ans A. Confusion

B. Attraction

C. Curiosity

D. ​​Dislike

Question Type : MCQ

Question ID : 630680796722

Option 1 ID : 6306803121862

Option 2 ID : 6306803121860

Option 3 ID : 6306803121861

Option 4 ID : 6306803121863

Status : Answered

Chosen Option : A

Marks : -0.25



Comprehension:

Read the given passage and answer the questions that follow.

Have you ever said "I hate you" to someone? What about using the 'h-word' in a casual
conversation, like "I hate broccoli"? What are you really feeling when you say that you hate
something or someone?

The Merriam-Webster dictionary describes the word 'hate' as an 'intense hostility and aversion
usually deriving from fear, anger or sense of injury'. All over the world, researchers are
studying hate from disciplines like education, history, law, leadership, psychology, sociology
and many others.

If you had a scary experience with thunderstorms, you might say that you hate
thunderstorms. Maybe you have gotten very angry at something that happened at a particular
place, so now you say you hate going there. Maybe someone said something hurtful to you,
so you say you hate that person.

Understanding hate as an emotional response can help you recognise your feelings about
something or someone and be curious about where those feelings are coming from. This
awareness will give you time to gather more information and imagine the other person’s
perspective.

SubQuestion No : 29

Q.29 What is the central theme of the passage?

Ans A. The definition and understanding of hate as an emotional response

B. The importance of studying emotions in various disciplines

C. Strategies to overcome negative emotions

D. The impact of fear on human behaviour

Question Type : MCQ

Question ID : 630680796718

Option 1 ID : 6306803121844

Option 2 ID : 6306803121846

Option 3 ID : 6306803121847

Option 4 ID : 6306803121845

Status : Answered

Chosen Option : A

Marks : 1



Comprehension:

Read the given passage and answer the questions that follow.

Have you ever said "I hate you" to someone? What about using the 'h-word' in a casual
conversation, like "I hate broccoli"? What are you really feeling when you say that you hate
something or someone?

The Merriam-Webster dictionary describes the word 'hate' as an 'intense hostility and aversion
usually deriving from fear, anger or sense of injury'. All over the world, researchers are
studying hate from disciplines like education, history, law, leadership, psychology, sociology
and many others.

If you had a scary experience with thunderstorms, you might say that you hate
thunderstorms. Maybe you have gotten very angry at something that happened at a particular
place, so now you say you hate going there. Maybe someone said something hurtful to you,
so you say you hate that person.

Understanding hate as an emotional response can help you recognise your feelings about
something or someone and be curious about where those feelings are coming from. This
awareness will give you time to gather more information and imagine the other person’s
perspective.

SubQuestion No : 30

Q.30 What does the passage suggest about understanding hate as an emotional response?

Ans A. It can make you more likely to act on your emotions immediately.

B. It can help you ignore your feelings about something or someone.

C. It can help you recognise your feelings and be curious about their origins.

D. It can prevent you from understanding the perspectives of others.

Question Type : MCQ

Question ID : 630680796720

Option 1 ID : 6306803121854

Option 2 ID : 6306803121852

Option 3 ID : 6306803121853

Option 4 ID : 6306803121855

Status : Answered

Chosen Option : C

Marks : 1



Comprehension:

Read the given passage and answer the questions that follow.
Suddenly his clutching fingers had found a rough edge of rock, and by raising and lowering his
wrists, he could cut the tough ropes against it.
Resolutely, Green applied himself to his task of cutting the ropes which bound his hands,
though, his muscles ached and his whole body was faint with fatigue. The vultures were near
now. He knew that it would not be long before they would descend to the attack. The thought
of those great, curved, cruel beaks and his own defenseless eyes made him shiver.
Suddenly one swooped down upon the prey. Green saw it coming and gave vent to a loud yell,
which sent the attacking bird on a wide sweep and momentarily scattered the others.
The birds wheeled in lessening circles above him. Again one of them dashed at his face but
swerved when he shouted. The whole flock was perilously near.
Summoning his remaining strength, he wrenched savagely at his bonds and succeeded in
cutting them.

SubQuestion No : 31

Q.31 Select the most suitable title for the given passage.

Ans A. Aching Muscles

B. A Loud Yell

C. Man vs Vultures

D. The Desert

Question Type : MCQ

Question ID : 630680640359

Option 1 ID : 6306802506988

Option 2 ID : 6306802506990

Option 3 ID : 6306802506989

Option 4 ID : 6306802506991

Status : Answered

Chosen Option : C

Marks : 1

Comprehension:

Read the given passage and answer the questions that follow.
Suddenly his clutching fingers had found a rough edge of rock, and by raising and lowering his
wrists, he could cut the tough ropes against it.
Resolutely, Green applied himself to his task of cutting the ropes which bound his hands,
though, his muscles ached and his whole body was faint with fatigue. The vultures were near
now. He knew that it would not be long before they would descend to the attack. The thought
of those great, curved, cruel beaks and his own defenseless eyes made him shiver.
Suddenly one swooped down upon the prey. Green saw it coming and gave vent to a loud yell,
which sent the attacking bird on a wide sweep and momentarily scattered the others.
The birds wheeled in lessening circles above him. Again one of them dashed at his face but
swerved when he shouted. The whole flock was perilously near.
Summoning his remaining strength, he wrenched savagely at his bonds and succeeded in
cutting them.

SubQuestion No : 32

Q.32 How can we relate Green's experience to our lives? Select the most appropriate option.

Ans A. If you are very tense and fatigued, find a rough rock to clutch onto.

B. If ever tied up, wrench savagely at your bonds.

C. If you are resolute and do not give up, you can overcome difficult situations.

D. Yell out loud if you are in an adverse situation.

Question Type : MCQ

Question ID : 630680640362

Option 1 ID : 6306802507001

Option 2 ID : 6306802507002

Option 3 ID : 6306802507003

Option 4 ID : 6306802507000

Status : Answered

Chosen Option : C

Marks : 1



Comprehension:

Read the given passage and answer the questions that follow.
Suddenly his clutching fingers had found a rough edge of rock, and by raising and lowering his
wrists, he could cut the tough ropes against it.
Resolutely, Green applied himself to his task of cutting the ropes which bound his hands,
though, his muscles ached and his whole body was faint with fatigue. The vultures were near
now. He knew that it would not be long before they would descend to the attack. The thought
of those great, curved, cruel beaks and his own defenseless eyes made him shiver.
Suddenly one swooped down upon the prey. Green saw it coming and gave vent to a loud yell,
which sent the attacking bird on a wide sweep and momentarily scattered the others.
The birds wheeled in lessening circles above him. Again one of them dashed at his face but
swerved when he shouted. The whole flock was perilously near.
Summoning his remaining strength, he wrenched savagely at his bonds and succeeded in
cutting them.

SubQuestion No : 33

Q.33 Identify the opposite of Fatigue, choosing your answer from the options given.

Ans A. Optimism

B. Weary

C. Fatalism

D. Vigour

Question Type : MCQ

Question ID : 630680640363

Option 1 ID : 6306802507007

Option 2 ID : 6306802507004

Option 3 ID : 6306802507006

Option 4 ID : 6306802507005

Status : Answered

Chosen Option : D

Marks : 1

Comprehension:

Read the given passage and answer the questions that follow.
Suddenly his clutching fingers had found a rough edge of rock, and by raising and lowering his
wrists, he could cut the tough ropes against it.
Resolutely, Green applied himself to his task of cutting the ropes which bound his hands,
though, his muscles ached and his whole body was faint with fatigue. The vultures were near
now. He knew that it would not be long before they would descend to the attack. The thought
of those great, curved, cruel beaks and his own defenseless eyes made him shiver.
Suddenly one swooped down upon the prey. Green saw it coming and gave vent to a loud yell,
which sent the attacking bird on a wide sweep and momentarily scattered the others.
The birds wheeled in lessening circles above him. Again one of them dashed at his face but
swerved when he shouted. The whole flock was perilously near.
Summoning his remaining strength, he wrenched savagely at his bonds and succeeded in
cutting them.

SubQuestion No : 34

Q.34 What idea did Green get to free himself from the thongs? Select the most appropriate
option.

Ans A. He could make his whole body tense and lie down quietly on the rocks.

B. He could kill the vultures and run away.

C. He could gather all his strength and face the vultures.

D. He could free himself from the tough ropes which bound his hands by raising and
lowering his wrists against the rough rock.

Question Type : MCQ

Question ID : 630680640361

Option 1 ID : 6306802506997

Option 2 ID : 6306802506996

Option 3 ID : 6306802506998

Option 4 ID : 6306802506999

Status : Answered

Chosen Option : D

Marks : 1



Comprehension:

Read the given passage and answer the questions that follow.
Suddenly his clutching fingers had found a rough edge of rock, and by raising and lowering his
wrists, he could cut the tough ropes against it.
Resolutely, Green applied himself to his task of cutting the ropes which bound his hands,
though, his muscles ached and his whole body was faint with fatigue. The vultures were near
now. He knew that it would not be long before they would descend to the attack. The thought
of those great, curved, cruel beaks and his own defenseless eyes made him shiver.
Suddenly one swooped down upon the prey. Green saw it coming and gave vent to a loud yell,
which sent the attacking bird on a wide sweep and momentarily scattered the others.
The birds wheeled in lessening circles above him. Again one of them dashed at his face but
swerved when he shouted. The whole flock was perilously near.
Summoning his remaining strength, he wrenched savagely at his bonds and succeeded in
cutting them.

SubQuestion No : 35

Q.35 What made Green yell out loud? Select the most appropriate option.

Ans A. Seeing a vulture swooping down upon him

B. When he was savagely trying to tear his bonds

C. Great physical pain and fatigue

D. Scattered vultures

Question Type : MCQ

Question ID : 630680640360

Option 1 ID : 6306802506994

Option 2 ID : 6306802506995

Option 3 ID : 6306802506992

Option 4 ID : 6306802506993

Status : Answered

Chosen Option : A

Marks : 1

Q.1

Ans A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801147642

Option 1 ID : 6306804510667

Option 2 ID : 6306804510668

Option 3 ID : 6306804510669

Option 4 ID : 6306804510666

Status : Answered

Chosen Option : A

Marks : 1

Section : Odia Language



Q.2

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801162584

Option 1 ID : 6306804569684

Option 2 ID : 6306804569685

Option 3 ID : 6306804569687

Option 4 ID : 6306804569686

Status : Answered

Chosen Option : D

Marks : -0.25

Q.3

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801154647

Option 1 ID : 6306804538508

Option 2 ID : 6306804538510

Option 3 ID : 6306804538509

Option 4 ID : 6306804538507

Status : Answered

Chosen Option : C

Marks : 1



Q.4

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801126966

Option 1 ID : 6306804428060

Option 2 ID : 6306804428061

Option 3 ID : 6306804428059

Option 4 ID : 6306804428058

Status : Answered

Chosen Option : A

Marks : 1

Q.5

Ans A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801124951

Option 1 ID : 6306804420019

Option 2 ID : 6306804420022

Option 3 ID : 6306804420020

Option 4 ID : 6306804420021

Status : Answered

Chosen Option : D

Marks : 1



Q.6

Ans A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801148525

Option 1 ID : 6306804514180

Option 2 ID : 6306804514181

Option 3 ID : 6306804514178

Option 4 ID : 6306804514179

Status : Answered

Chosen Option : D

Marks : 1

Q.7

Ans A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801124908

Option 1 ID : 6306804419854

Option 2 ID : 6306804419851

Option 3 ID : 6306804419853

Option 4 ID : 6306804419852

Status : Answered

Chosen Option : B

Marks : -0.25



Q.8

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801119821

Option 1 ID : 6306804399613

Option 2 ID : 6306804399615

Option 3 ID : 6306804399616

Option 4 ID : 6306804399614

Status : Answered

Chosen Option : A

Marks : 1

Q.9

Ans A.

B.

C.

D.

Question Type : MCQ

Question ID : 6306801135271

Option 1 ID : 6306804461263

Option 2 ID : 6306804461262

Option 3 ID : 6306804461265

Option 4 ID : 6306804461264

Status : Answered

Chosen Option : A

Marks : 1



Q.10

Ans A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801144706

Option 1 ID : 6306804498997

Option 2 ID : 6306804498996

Option 3 ID : 6306804498994

Option 4 ID : 6306804498995

Status : Answered

Chosen Option : A

Marks : 1

Q.11

Ans A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801154765

Option 1 ID : 6306804538978

Option 2 ID : 6306804538977

Option 3 ID : 6306804538976

Option 4 ID : 6306804538975

Status : Answered

Chosen Option : C

Marks : 1



Q.12

Ans A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801135326

Option 1 ID : 6306804461484

Option 2 ID : 6306804461485

Option 3 ID : 6306804461482

Option 4 ID : 6306804461483

Status : Answered

Chosen Option : A

Marks : 1

Q.13

Ans A.

B.

C.

D.

Question Type : MCQ

Question ID : 6306801162598

Option 1 ID : 6306804569743

Option 2 ID : 6306804569741

Option 3 ID : 6306804569740

Option 4 ID : 6306804569742

Status : Answered

Chosen Option : D

Marks : 1



Q.14

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801158009

Option 1 ID : 6306804551171

Option 2 ID : 6306804551169

Option 3 ID : 6306804551170

Option 4 ID : 6306804551168

Status : Answered

Chosen Option : B

Marks : 1

Q.15

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801104572

Option 1 ID : 6306804338817

Option 2 ID : 6306804338820

Option 3 ID : 6306804338818

Option 4 ID : 6306804338819

Status : Answered

Chosen Option : D

Marks : -0.25



Q.16

Ans A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801101035

Option 1 ID : 6306804325390

Option 2 ID : 6306804325387

Option 3 ID : 6306804325389

Option 4 ID : 6306804325388

Status : Answered

Chosen Option : D

Marks : -0.25

Q.17

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801156750

Option 1 ID : 6306804546241

Option 2 ID : 6306804546240

Option 3 ID : 6306804546243

Option 4 ID : 6306804546242

Status : Answered

Chosen Option : D

Marks : 1



Q.18

Ans A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801148463

Option 1 ID : 6306804513931

Option 2 ID : 6306804513932

Option 3 ID : 6306804513930

Option 4 ID : 6306804513933

Status : Answered

Chosen Option : D

Marks : 1

Q.19

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801122174

Option 1 ID : 6306804408993

Option 2 ID : 6306804408995

Option 3 ID : 6306804408996

Option 4 ID : 6306804408994

Status : Answered

Chosen Option : B

Marks : 1



Q.20

Ans A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801157238

Option 1 ID : 6306804548122

Option 2 ID : 6306804548123

Option 3 ID : 6306804548124

Option 4 ID : 6306804548125

Status : Answered

Chosen Option : B

Marks : 1

Comprehension:

SubQuestion No : 21

Q.21

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801152094

Option 1 ID : 6306804528361

Option 2 ID : 6306804528362

Option 3 ID : 6306804528364

Option 4 ID : 6306804528363

Status : Answered

Chosen Option : B

Marks : 1



Comprehension:

SubQuestion No : 22

Q.22

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801152095

Option 1 ID : 6306804528366

Option 2 ID : 6306804528368

Option 3 ID : 6306804528367

Option 4 ID : 6306804528365

Status : Answered

Chosen Option : B

Marks : 1



Comprehension:

SubQuestion No : 23

Q.23

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801152091

Option 1 ID : 6306804528351

Option 2 ID : 6306804528352

Option 3 ID : 6306804528350

Option 4 ID : 6306804528349

Status : Answered

Chosen Option : C

Marks : -0.25



Comprehension:

SubQuestion No : 24

Q.24

Ans A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801152092

Option 1 ID : 6306804528356

Option 2 ID : 6306804528353

Option 3 ID : 6306804528354

Option 4 ID : 6306804528355

Status : Answered

Chosen Option : D

Marks : -0.25



Comprehension:

SubQuestion No : 25

Q.25

Ans A.

B.

C.

D.

Question Type : MCQ

Question ID : 6306801152093

Option 1 ID : 6306804528359

Option 2 ID : 6306804528360

Option 3 ID : 6306804528358

Option 4 ID : 6306804528357

Status : Answered

Chosen Option : A

Marks : 1



Comprehension:

SubQuestion No : 26

Q.26

Ans A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801147482

Option 1 ID : 6306804510043

Option 2 ID : 6306804510042

Option 3 ID : 6306804510041

Option 4 ID : 6306804510040

Status : Answered

Chosen Option : B

Marks : 1



Comprehension:

SubQuestion No : 27

Q.27

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801147484

Option 1 ID : 6306804510051

Option 2 ID : 6306804510048

Option 3 ID : 6306804510049

Option 4 ID : 6306804510050

Status : Answered

Chosen Option : D

Marks : 1



Comprehension:

SubQuestion No : 28

Q.28

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801147481

Option 1 ID : 6306804510039

Option 2 ID : 6306804510037

Option 3 ID : 6306804510036

Option 4 ID : 6306804510038

Status : Answered

Chosen Option : B

Marks : 1



Comprehension:

SubQuestion No : 29

Q.29

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801147480

Option 1 ID : 6306804510032

Option 2 ID : 6306804510033

Option 3 ID : 6306804510034

Option 4 ID : 6306804510035

Status : Answered

Chosen Option : A

Marks : -0.25



Comprehension:

SubQuestion No : 30

Q.30

Ans A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801147483

Option 1 ID : 6306804510045

Option 2 ID : 6306804510047

Option 3 ID : 6306804510044

Option 4 ID : 6306804510046

Status : Answered

Chosen Option : A

Marks : 1



Comprehension:

SubQuestion No : 31

Q.31

Ans A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801136135

Option 1 ID : 6306804464699

Option 2 ID : 6306804464702

Option 3 ID : 6306804464701

Option 4 ID : 6306804464700

Status : Answered

Chosen Option : D

Marks : -0.25



Comprehension:

SubQuestion No : 32

Q.32

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801136136

Option 1 ID : 6306804464704

Option 2 ID : 6306804464706

Option 3 ID : 6306804464703

Option 4 ID : 6306804464705

Status : Answered

Chosen Option : C

Marks : 1



Comprehension:

SubQuestion No : 33

Q.33

Ans A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801136134

Option 1 ID : 6306804464698

Option 2 ID : 6306804464695

Option 3 ID : 6306804464696

Option 4 ID : 6306804464697

Status : Answered

Chosen Option : C

Marks : 1



Comprehension:

SubQuestion No : 34

Q.34

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801136137

Option 1 ID : 6306804464707

Option 2 ID : 6306804464708

Option 3 ID : 6306804464709

Option 4 ID : 6306804464710

Status : Answered

Chosen Option : D

Marks : 1



Comprehension:

SubQuestion No : 35

Q.35

Ans
A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 6306801136138

Option 1 ID : 6306804464714

Option 2 ID : 6306804464712

Option 3 ID : 6306804464713

Option 4 ID : 6306804464711

Status : Answered

Chosen Option : D

Marks : 1

Section : General Science



Q.1 In a wave, the distance from the centre line (or the still position) to the top of a crest or to
the bottom of a trough is called the ________ of the wave.

Ans A. frequency

B. amplitude

C. node

D. antinode

Question Type : MCQ

Question ID : 630680310235

Option 1 ID : 6306801207070

Option 2 ID : 6306801207069

Option 3 ID : 6306801207071

Option 4 ID : 6306801207072

Status : Answered

Chosen Option : B

Marks : 1

Q.2 What is the main purpose of marinating meat before cooking?

Ans A. Enhancing flavour and tenderness

B. Adding colour to the meat

C. Preserving the meat for a longer period

D. Reducing the cooking time

Question Type : MCQ

Question ID : 630680619032

Option 1 ID : 6306802422406

Option 2 ID : 6306802422404

Option 3 ID : 6306802422407

Option 4 ID : 6306802422405

Status : Answered

Chosen Option : D

Marks : -0.25

Q.3 Which non-membrane-bound cell structures are attached to the cytosolic face of the
endoplasmic reticulum membrane?

Ans A. Peroxisomes

B. Glyoxysomes

C. Ribosomes

D. Lysosomes

Question Type : MCQ

Question ID : 630680562539

Option 1 ID : 6306802199077

Option 2 ID : 6306802199078

Option 3 ID : 6306802199080

Option 4 ID : 6306802199079

Status : Answered

Chosen Option : D

Marks : -0.25



Q.4 Which of the following formulas is true?

Ans
A. Impulse = 

B. Impulse = Momentum

C. Impulse = Change in momentum

D. Impulse = Force

Question Type : MCQ

Question ID : 630680764406

Option 1 ID : 6306802996164

Option 2 ID : 6306802996166

Option 3 ID : 6306802996165

Option 4 ID : 6306802996163

Status : Not Answered

Chosen Option : --

Marks : 0

Q.5 What is the main goal of India's Very Short-Range Air Defence (VSHORAD) missile system?

Ans A. To intercept long-range ballistic missiles

B. To attack ground-based bunkers

C. To neutralise low-altitude aerial threats

D. To provide satellite surveillance

Question Type : MCQ

Question ID : 6306801065101

Option 1 ID : 6306804182681

Option 2 ID : 6306804182684

Option 3 ID : 6306804182682

Option 4 ID : 6306804182683

Status : Not Answered

Chosen Option : --

Marks : 0

Q.6 Which of the following schemes aims to attract meritorious youth to study basic and natural
sciences at the college and university level?

Ans A. Prayas

B. Nidhi

C. Inspire

D. Sunil

Question Type : MCQ

Question ID : 630680884889

Option 1 ID : 6306803465432

Option 2 ID : 6306803465430

Option 3 ID : 6306803465431

Option 4 ID : 6306803465429

Status : Answered

Chosen Option : A

Marks : -0.25



Q.7 In which month of 2024 did the Indian Army launch the first phase of Project NAMAN,
aimed at providing support and services to Defence Pensioners through the SPARSH digital
pension system?

Ans A. April

B. August

C. June

D. January

Question Type : MCQ

Question ID : 6306801065007

Option 1 ID : 6306804182315

Option 2 ID : 6306804182314

Option 3 ID : 6306804182313

Option 4 ID : 6306804182316

Status : Not Answered

Chosen Option : --

Marks : 0

Q.8 The definition of which law is given here?
‘The magnetic field created by an electric current is proportional to the size of that electric
current, with a constant of proportionality equal to the permeability of free space.’

Ans A. Ohm’s law

B. Gauss’s law

C. Ampere’s law

D. Coulomb’s law

Question Type : MCQ

Question ID : 63068056740

Option 1 ID : 630680218897

Option 2 ID : 630680218895

Option 3 ID : 630680218894

Option 4 ID : 630680218896

Status : Answered

Chosen Option : C

Marks : 1

Q.9 With reference to the following submarines, select the correct option that was/were built
under the Project-75 Scorpene programme.

i. Kalvari
ii. Khanderi
iii. Karanj
iv. Vela

Ans A. i and ii

B. ii, iii and iv

C. i, ii, iii and iv

D. i, ii and iv

Question Type : MCQ

Question ID : 630680867659

Option 1 ID : 6306803398281

Option 2 ID : 6306803398283

Option 3 ID : 6306803398280

Option 4 ID : 6306803398282

Status : Not Answered

Chosen Option : --

Marks : 0



Q.10 If black pepper is adulterated by mixing with papaya seeds, how can you detect the
adulterant?

Ans A. They can be separated manually, seed by seed.

B. Papaya seeds float in water.

C. Both float in water, and thus can’t be detected using this method.

D. Pure black pepper floats in water.

Question Type : MCQ

Question ID : 630680640945

Option 1 ID : 6306802509223

Option 2 ID : 6306802509221

Option 3 ID : 6306802509222

Option 4 ID : 6306802509220

Status : Answered

Chosen Option : D

Marks : -0.25

Q.11 Where was the venue of the 5th ASEAN-India Trade in Goods Agreement (AITIGA) Joint
Committee meeting held in 2024?

Ans A. Putrajaya

B. Mumbai

C. Jakarta

D. New Delhi

Question Type : MCQ

Question ID : 6306801063407

Option 1 ID : 6306804175992

Option 2 ID : 6306804175994

Option 3 ID : 6306804175991

Option 4 ID : 6306804175993

Status : Not Answered

Chosen Option : --

Marks : 0

Q.12 Who emerged as the winner of the Women's T20 Asia Cup 2024?

Ans A. Sri Lanka

B. India

C. Thailand

D. Malaysia

Question Type : MCQ

Question ID : 6306801061998

Option 1 ID : 6306804170377

Option 2 ID : 6306804170378

Option 3 ID : 6306804170379

Option 4 ID : 6306804170380

Status : Answered

Chosen Option : B

Marks : -0.25

Section : Current Events



Q.13 In Union Budget June 2024-25, what new limit has been set under Pradhan Mantri Mudra
Loan under Tarun category for those who have availed and successfully repaid loans
previously?

Ans A. ₹20 lakh

B. ₹35 lakh

C. ₹25 lakh

D. ₹15 lakh

Question Type : MCQ

Question ID : 6306801050093

Option 1 ID : 6306804122718

Option 2 ID : 6306804122719

Option 3 ID : 6306804122720

Option 4 ID : 6306804122717

Status : Not Answered

Chosen Option : --

Marks : 0

Q.14 Where was the UEFA EURO 2024 final played between Spain and England?

Ans A. Wembley Stadium, London

B. Allianz Arena, Munich

C. Santiago Bernabéu Stadium, Madrid

D. Olympiastadion, Berlin

Question Type : MCQ

Question ID : 6306801057325

Option 1 ID : 6306804151711

Option 2 ID : 6306804151714

Option 3 ID : 6306804151712

Option 4 ID : 6306804151713

Status : Not Answered

Chosen Option : --

Marks : 0

Q.15 Jyotiraditya M Scindia took charge of which ministry in June 2024?

Ans A. Ministry of Commerce and Industry

B. Ministry of Panchayati Raj

C. Ministry of Education

D. Ministry of Communications

Question Type : MCQ

Question ID : 6306801050032

Option 1 ID : 6306804122477

Option 2 ID : 6306804122479

Option 3 ID : 6306804122478

Option 4 ID : 6306804122480

Status : Answered

Chosen Option : A

Marks : -0.25



Q.16 How much cash prize was promised in the Hockey India Balbir Singh Sr. Award 2023 for
Player of the Year in both men's and women's categories?

Ans A. 25 lakh

B. 30 lakh

C. 10 lakh

D. 15 lakh

Question Type : MCQ

Question ID : 630680766948

Option 1 ID : 6306803006075

Option 2 ID : 6306803006076

Option 3 ID : 6306803006073

Option 4 ID : 6306803006074

Status : Not Answered

Chosen Option : --

Marks : 0

Q.17 As of 2023, which of the following countries is NOT a member of the G20?

Ans A. Norway

B. Saudi Arabia

C. Argentina

D. South Korea

Question Type : MCQ

Question ID : 6306801057378

Option 1 ID : 6306804151910

Option 2 ID : 6306804151908

Option 3 ID : 6306804151907

Option 4 ID : 6306804151909

Status : Answered

Chosen Option : C

Marks : -0.25

Q.18 Who among the following was conferred the Major Dhyan Chand Khel Ratna Award, 2023?

Ans A. Mohammed Shami

B. Anush Agarwalla

C. Chirag Chandrashekhar Shetty

D. Ojas Pravin Deotale

Question Type : MCQ

Question ID : 630680625126

Option 1 ID : 6306802446707

Option 2 ID : 6306802446708

Option 3 ID : 6306802446705

Option 4 ID : 6306802446706

Status : Answered

Chosen Option : C

Marks : 1



Q.19 Which of the following organisations approved a $1.5 billion loan in 2024 to help India
develop its low-carbon energy sector?

Ans A. International Monetary Fund (IMF)

B. European Investment Bank (EIB)

C. World Bank (WB)

D. Asian Development Bank (ADB)

Question Type : MCQ

Question ID : 6306801057024

Option 1 ID : 6306804150521

Option 2 ID : 6306804150523

Option 3 ID : 6306804150522

Option 4 ID : 6306804150524

Status : Not Answered

Chosen Option : --

Marks : 0

Q.20 Which of the following cities hosted the BRICS Games in 2024?

Ans A. Mumbai

B. Durban

C. Kazan

D. Sao Paulo

Question Type : MCQ

Question ID : 6306801062221

Option 1 ID : 6306804171270

Option 2 ID : 6306804171271

Option 3 ID : 6306804171269

Option 4 ID : 6306804171272

Status : Answered

Chosen Option : B

Marks : -0.25

Q.21 The founder of Satavahana dynasty is _________.

Ans A. Simuka

B. Pravarasena I

C. Dantivarman

D. Vasudeva

Question Type : MCQ

Question ID : 630680595797

Option 1 ID : 6306802331379

Option 2 ID : 6306802331378

Option 3 ID : 6306802331377

Option 4 ID : 6306802331376

Status : Answered

Chosen Option : A

Marks : 1

Section : History of India



Q.22 Which of the following was the original capital of Rashtrakuta?

Ans A. Paithan

B. Badami

C. Ellora

D. Manyakhet

Question Type : MCQ

Question ID : 630680571953

Option 1 ID : 6306802236708

Option 2 ID : 6306802236710

Option 3 ID : 6306802236711

Option 4 ID : 6306802236709

Status : Answered

Chosen Option : B

Marks : -0.25

Q.23 The Government of India Act or the Mont-Ford reforms were introduced in ________.

Ans A. 1914

B. 1909

C. 1857

D. 1919

Question Type : MCQ

Question ID : 630680616293

Option 1 ID : 6306802411853

Option 2 ID : 6306802411852

Option 3 ID : 6306802411851

Option 4 ID : 6306802411854

Status : Not Answered

Chosen Option : --

Marks : 0

Q.24 During the rule of which Post Mauryan dynasty was Charakasamhita composed?

Ans A. Indo-Greeks

B. Shungas

C. Kushans

D. Parthians

Question Type : MCQ

Question ID : 630680571345

Option 1 ID : 6306802234413

Option 2 ID : 6306802234415

Option 3 ID : 6306802234416

Option 4 ID : 6306802234414

Status : Answered

Chosen Option : C

Marks : 1



Q.25 Who among the following was falsely accused of beating the guard to death and sentenced
to death on 29 March 1943 in Berhampur Central Jail?

Ans A. Uddant Sai

B. Surendra Nath Dwivedi

C. Bibhudendu Mishra

D. Laxman Naik

Question Type : MCQ

Question ID : 6306801135773

Option 1 ID : 6306804463191

Option 2 ID : 6306804463193

Option 3 ID : 6306804463192

Option 4 ID : 6306804463190

Status : Answered

Chosen Option : D

Marks : 1

Q.26 In which year was the first Forest Act enacted to consolidate the law related to forests?

Ans A. 1952

B. 1927

C. 1919

D. 1935

Question Type : MCQ

Question ID : 630680616285

Option 1 ID : 6306802411822

Option 2 ID : 6306802411819

Option 3 ID : 6306802411820

Option 4 ID : 6306802411821

Status : Not Answered

Chosen Option : --

Marks : 0

Q.27 Which treaty was concluded to end the first Anglo-Maratha war?

Ans A. Salbai

B. Pune

C. Deogaon

D. Bassein

Question Type : MCQ

Question ID : 630680577702

Option 1 ID : 6306802259652

Option 2 ID : 6306802259654

Option 3 ID : 6306802259655

Option 4 ID : 6306802259653

Status : Answered

Chosen Option : A

Marks : 1



Q.28 Which of the following empires is believed to have had the best cavalry of the time in India?

Ans A. Rashtrakutas

B. Pratiharas

C. Chalukyas

D. Palas

Question Type : MCQ

Question ID : 630680571549

Option 1 ID : 6306802235231

Option 2 ID : 6306802235230

Option 3 ID : 6306802235232

Option 4 ID : 6306802235229

Status : Not Answered

Chosen Option : --

Marks : 0

Q.29 The Vernacular Press Act was repealed by which of the following Governor Generals of
British India in 1881?

Ans A. Lord Ripon

B. Lord Chelmsford

C. Lord Dufferin

D. Lord Curzon

Question Type : MCQ

Question ID : 630680477025

Option 1 ID : 6306801863301

Option 2 ID : 6306801863304

Option 3 ID : 6306801863302

Option 4 ID : 6306801863303

Status : Answered

Chosen Option : B

Marks : -0.25

Q.30 In which Indian state was Ram Manohar Lohia born?

Ans A. Rajasthan

B. West Bengal

C. Bihar

D. Uttar Pradesh

Question Type : MCQ

Question ID : 630680607645

Option 1 ID : 6306802377711

Option 2 ID : 6306802377710

Option 3 ID : 6306802377712

Option 4 ID : 6306802377709

Status : Answered

Chosen Option : D

Marks : 1

Section : Geography



Q.31 In which direction do most major mineral resources occur in relation to a line linking
Mangaluru and Kanpur in India?

Ans A. West

B. North

C. South

D. East

Question Type : MCQ

Question ID : 630680662902

Option 1 ID : 6306802595272

Option 2 ID : 6306802595274

Option 3 ID : 6306802595275

Option 4 ID : 6306802595273

Status : Answered

Chosen Option : B

Marks : -0.25

Q.32 In which state, the ‘slash and burn’ agriculture is known as ‘Valre’?

Ans A. Manipur

B. Jharkhand

C. Himachal Pradesh

D. Rajasthan

Question Type : MCQ

Question ID : 630680652048

Option 1 ID : 6306802552715

Option 2 ID : 6306802552717

Option 3 ID : 6306802552716

Option 4 ID : 6306802552714

Status : Answered

Chosen Option : C

Marks : -0.25

Q.33 Which of the following represent the major types of vegetation identified in India?

Ans A. (i) Tropical Evergreen Forests (ii) Tropical Deciduous Forests (iii) Tropical Thorn
Forests and Scrubs (iv) Montane Forests (v) Mangrove Forests

B. (i) Desert Scrub (ii) Coniferous Forests (iii) Alpine Tundra (iv) Savanna Grasslands (v)
Temperate Rainforests

C. (i) Temperate Forests (ii) Taiga Forests (iii) Mediterranean Forests (iv) Savanna
Grasslands (v) Tundra

D. (i) Temperate Grasslands (ii) Tropical Rainforests

Question Type : MCQ

Question ID : 630680683199

Option 1 ID : 6306802675516

Option 2 ID : 6306802675517

Option 3 ID : 6306802675515

Option 4 ID : 6306802675518

Status : Answered

Chosen Option : A

Marks : 1



Q.34 The South West Indian Ocean is the most biodiverse oceanic region in Africa and
____________ most biodiverse in the world.

Ans A. fifth

B. second

C. fourth

D. third

Question Type : MCQ

Question ID : 6306801064207

Option 1 ID : 6306804179170

Option 2 ID : 6306804179167

Option 3 ID : 6306804179169

Option 4 ID : 6306804179168

Status : Not Answered

Chosen Option : --

Marks : 0

Q.35 Consider the following statements about the Himalayas:

1). The Himalayas are the youngest and highest mountain range in the world.
2). They extend from the Indus River in the west to the Brahmaputra River in the east.
3). The Aravalli Range is a part of the Himalayan system.

Which of the above statements are correct?

Ans A. Only 1 and 3

B. All 1, 2, and 3

C. Only 1 and 2

D. Only 2 and 3

Question Type : MCQ

Question ID : 630680871872

Option 1 ID : 6306803414588

Option 2 ID : 6306803414589

Option 3 ID : 6306803414586

Option 4 ID : 6306803414587

Status : Answered

Chosen Option : D

Marks : -0.25

Q.36 The river that rises from the Manipur hills is called ____.

Ans A. Dibang

B. Teesta

C. Lohit

D. Barak

Question Type : MCQ

Question ID : 630680590650

Option 1 ID : 6306802311085

Option 2 ID : 6306802311086

Option 3 ID : 6306802311084

Option 4 ID : 6306802311083

Status : Not Answered

Chosen Option : --

Marks : 0



Q.37 Which of the following states in India is known for its extensive Mangrove forests and the
Sundarbans delta?

Ans A. West Bengal

B. Odisha

C. Kerala

D. Gujarat

Question Type : MCQ

Question ID : 630680871855

Option 1 ID : 6306803414517

Option 2 ID : 6306803414516

Option 3 ID : 6306803414514

Option 4 ID : 6306803414515

Status : Answered

Chosen Option : A

Marks : 1

Q.38 What is the total length of the National Highways in India as of 2023?

Ans A. 1,46,145 km

B. 89,745 km

C. 1,89,000 km

D. 1,23,365 km

Question Type : MCQ

Question ID : 630680701054

Option 1 ID : 6306802746147

Option 2 ID : 6306802746148

Option 3 ID : 6306802746145

Option 4 ID : 6306802746146

Status : Not Answered

Chosen Option : --

Marks : 0

Q.39 Which of the following is correct about the 'Loo'?

Ans A. It causes coffee flowers to blossom.

B. It brings pre-monsoon showers that help in the ripening of mangoes.

C. It is known for aiding the cultivation of tea, jute, and rice.​​​

D. It is a hot, dry, and oppressing wind blowing in the northern plains.

Question Type : MCQ

Question ID : 630680873671

Option 1 ID : 6306803421678

Option 2 ID : 6306803421676

Option 3 ID : 6306803421679

Option 4 ID : 6306803421677

Status : Answered

Chosen Option : D

Marks : 1



Q.40 Tundra regions are also considered deserts as these typically get less than ______________ of
precipitation annually.

Ans A. 25 cm

B. 200 cm

C. 75 cm

D. 100 cm

Question Type : MCQ

Question ID : 6306801064359

Option 1 ID : 6306804179767

Option 2 ID : 6306804179766

Option 3 ID : 6306804179768

Option 4 ID : 6306804179765

Status : Not Answered

Chosen Option : --

Marks : 0

Q.41 Financial market reforms in India DID NOT include which of the following?

Ans A. Establishment of Securities and Exchange Board of India

B. Establishment of Insurance Regulatory and Development Authority

C. Establishment of National Stock Exchange

D. Establishment of Telecom Regulatory Authority of India

Question Type : MCQ

Question ID : 6306801148071

Option 1 ID : 6306804512382

Option 2 ID : 6306804512385

Option 3 ID : 6306804512383

Option 4 ID : 6306804512384

Status : Not Answered

Chosen Option : --

Marks : 0

Q.42 As per which Article of the Indian Constitution is it the fundamental duty of a parent or
guardian to provide opportunities for education to their child or ward between the ages of 6
and 14 years?

Ans A. Article 51A

B. Article 21A

C. Article 45

D. Article 39

Question Type : MCQ

Question ID : 630680783793

Option 1 ID : 6306803071542

Option 2 ID : 6306803071539

Option 3 ID : 6306803071541

Option 4 ID : 6306803071540

Status : Answered

Chosen Option : B

Marks : -0.25

Section : Indian polity and Economy



Q.43 Which of the following is NOT a component of economic infrastructure?

Ans A. Transportation systems

B. Power supply systems

C. Telecommunications networks

D. Health facilities

Question Type : MCQ

Question ID : 630680209044

Option 1 ID : 630680810394

Option 2 ID : 630680810391

Option 3 ID : 630680810392

Option 4 ID : 630680810393

Status : Answered

Chosen Option : D

Marks : 1

Q.44 In which of the following years was the first Industrial Policy announced?

Ans A. 1951

B. 1948

C. 1950

D. 1952

Question Type : MCQ

Question ID : 6306801148063

Option 1 ID : 6306804512350

Option 2 ID : 6306804512352

Option 3 ID : 6306804512353

Option 4 ID : 6306804512351

Status : Not Answered

Chosen Option : --

Marks : 0

Q.45 Odisha Mineral Bearing Areas Development Corporation (OMBADC) was formed in which
year for undertaking specific tribal welfare and area development works to ensure inclusive
growth of the mineral bearing areas of the state?

Ans A. 2011

B. 2014

C. 2010

D. 2017

Question Type : MCQ

Question ID : 6306801146910

Option 1 ID : 6306804507773

Option 2 ID : 6306804507774

Option 3 ID : 6306804507772

Option 4 ID : 6306804507775

Status : Not Answered

Chosen Option : --

Marks : 0



Q.46 Which of the following authorities is responsible for the termination of Indian citizenship as
per the Citizenship Act, 1955?

Ans A. The President of India

B. The Ministry of Home Affairs

C. The Supreme Court of India

D. The Parliament

Question Type : MCQ

Question ID : 630680783859

Option 1 ID : 6306803071803

Option 2 ID : 6306803071805

Option 3 ID : 6306803071804

Option 4 ID : 6306803071806

Status : Answered

Chosen Option : C

Marks : -0.25

Q.47 Identify the States which were Union Territories earlier in India.

Ans A. Himachal Pradesh, Meghalaya and Tripura

B. Manipur, Sikkim and Tripura only

C. Himachal Pradesh, Manipur and Tripura only

D. Himachal Pradesh, Manipur, Sikkim and Tripura

Question Type : MCQ

Question ID : 630680595373

Option 1 ID : 6306802329687

Option 2 ID : 6306802511109

Option 3 ID : 6306802329686

Option 4 ID : 6306802329685

Status : Not Answered

Chosen Option : --

Marks : 0

Q.48 Which of the following does Part IVA of the Indian Constitution deal with?

Ans A. Citizenship

B. Fundamental Rights

C. Fundamental Duties

D. Directive Principles of State Policy

Question Type : MCQ

Question ID : 6306801125642

Option 1 ID : 6306804422767

Option 2 ID : 6306804422765

Option 3 ID : 6306804422766

Option 4 ID : 6306804422768

Status : Answered

Chosen Option : B

Marks : -0.25



Q.49 Which of the following banks was set up in 1964?

Ans A. Reserve Bank of India

B. Union Bank of India

C. Punjab and Sind Bank

D. Industrial Development Bank of India

Question Type : MCQ

Question ID : 630680665566

Option 1 ID : 6306802605824

Option 2 ID : 6306802605827

Option 3 ID : 6306802605826

Option 4 ID : 6306802605825

Status : Answered

Chosen Option : A

Marks : -0.25

Q.50 As of September 2024, how many district courts are there in Odisha?

Ans A. 30

B. 35

C. 38

D. 33

Question Type : MCQ

Question ID : 6306801126276

Option 1 ID : 6306804425318

Option 2 ID : 6306804425320

Option 3 ID : 6306804425321

Option 4 ID : 6306804425319

Status : Not Answered

Chosen Option : --

Marks : 0

Q.51 Read the given statements and conclusions carefully. Assuming that the information given
in the statements is true, even if it appears to be at variance with commonly known facts,
decide which of the given conclusions logically follow(s) from the statements.

Statements: Some trees are plants. Some plants are branches.

Conclusion (I): Some trees are branches.
Conclusion (II): All branches are plants.

Ans A. Neither conclusion (I) nor (II) follows.

B. Both conclusions (I) and (II) follow.

C. Only conclusion (II) follows.

D. Only conclusion (I) follows.

Question Type : MCQ

Question ID : 630680916196

Option 1 ID : 6306803589922

Option 2 ID : 6306803589923

Option 3 ID : 6306803589924

Option 4 ID : 6306803589925

Status : Answered

Chosen Option : D

Marks : -0.25

Section : Mental ability



Q.52 Seven boxes A, B, C, D, E, F and G are kept one above the other but not necessarily in the
same order. Only three boxes are kept below D. Only two boxes are kept between D and G.
Only C is kept above B. A is kept at some place below F and at some place above E. How
many boxes are kept above B?

Ans A. Four

B. Two

C. Three

D. One

Question Type : MCQ

Question ID : 630680942293

Option 1 ID : 6306803693822

Option 2 ID : 6306803693820

Option 3 ID : 6306803693821

Option 4 ID : 6306803693819

Status : Answered

Chosen Option : D

Marks : 1

Q.53 Refer to the given series and answer the question that follows (all numbers are single digit
numbers only).

(Left) 7 9 2 4 7 3 4 2 1 5 1 5 8 5 3 7 8 4 3 6 2 6 9 7 4 5 1 (Right)

How many such even digits are there, each of which is immediately preceded by an odd
digit and also immediately followed by an even digit?

Ans A. 4

B. 5

C. 6

D. 3

Question Type : MCQ

Question ID : 630680959432

Option 1 ID : 6306803761515

Option 2 ID : 6306803761516

Option 3 ID : 6306803761517

Option 4 ID : 6306803761514

Status : Answered

Chosen Option : B

Marks : -0.25

Q.54 Steve starts from Point A and drives 6 km towards North. He then takes a left turn, drives 4
km, turns left and drives 8 km. He then takes a left turn and drives 10 km. He takes a final
left turn, drives 2 km and stops at Point P. How far (shortest distance) and towards which
direction should he drive in order to reach Point A again? (All turns are 90 degrees turns
only unless specified)

Ans A. 2 km West

B. 5 km South

C. 6 km West

D. 8 km North

Question Type : MCQ

Question ID : 630680750645

Option 1 ID : 6306802942020

Option 2 ID : 6306802942021

Option 3 ID : 6306802942019

Option 4 ID : 6306802942022

Status : Answered

Chosen Option : C

Marks : 1



Q.55 Each of P, Q, R, S, T, U and V has an exam on a different day of a week starting from Monday
and ending on Sunday of the same week. U has an exam on Friday. Only two people have an
exam between U and R. Q has an exam immediately before V, and S has an exam
immediately after T. Only two people have an exam between P and V. How many people
have exam(s) between R and V?

Ans A. One

B. Two

C. Four

D. Three

Question Type : MCQ

Question ID : 630680908585

Option 1 ID : 6306803559410

Option 2 ID : 6306803559411

Option 3 ID : 6306803559413

Option 4 ID : 6306803559412

Status : Not Answered

Chosen Option : --

Marks : 0

Q.56 Read the given statements and conclusions carefully. Assuming that the information given
in the statements is true, even if it appears to be at variance with commonly known facts,
decide which of the given conclusions logically follow(s) from the statements.

Statements: Some bottles are animals. All animals are tablets.

Conclusion (I): Some bottles are tablets.
Conclusion (II): All tablets are animals.

Ans A. Only conclusion (I) follows.

B. Only conclusion (II) follows.

C. Neither conclusion (I) nor (II) follows.

D. Both conclusions (I) and (II) follow.

Question Type : MCQ

Question ID : 630680916194

Option 1 ID : 6306803589906

Option 2 ID : 6306803589907

Option 3 ID : 6306803589908

Option 4 ID : 6306803589909

Status : Answered

Chosen Option : A

Marks : 1



Q.57 Refer to the given series and answer the question that follows (all numbers are single digit
numbers only).

(Left) 6 1 2 4 9 7 2 1 5 7 3 7 8 4 3 9 5 5 7 8 5 3 4 6 2 1 4 (Right)

How many such even digits are there, each of which is immediately preceded by an odd
digit and also immediately followed by an even digit?

Ans A. 2

B. 5

C. 4

D. 3

Question Type : MCQ

Question ID : 630680942547

Option 1 ID : 6306803694630

Option 2 ID : 6306803694633

Option 3 ID : 6306803694632

Option 4 ID : 6306803694631

Status : Answered

Chosen Option : D

Marks : 1

Q.58 In a certain code language,

A + B means ‘A is the daughter of B’,
A – B means ‘A is the brother of B’,
A x B means ‘A is the mother of B’ and
A ÷ B means ‘A is the father of B’.

Based on the above, how is P related to T if ‘P x Q ÷ R – S + T’?

Ans A. Mother’s mother

B. Husband’s mother

C. Father’s sister

D. Husband’s sister

Question Type : MCQ

Question ID : 630680732913

Option 1 ID : 6306802872461

Option 2 ID : 6306802872463

Option 3 ID : 6306802872462

Option 4 ID : 6306802872464

Status : Not Answered

Chosen Option : --

Marks : 0

Q.59 In a certain code language, ‘play this song’ is coded as ‘mv bg sp’ and ‘is song over’ is coded
as ‘bg km cy’. How is ‘song’ coded in the given language?

Ans A. km

B. bg

C. mv

D. sp

Question Type : MCQ

Question ID : 630680909912

Option 1 ID : 6306803564595

Option 2 ID : 6306803564597

Option 3 ID : 6306803564594

Option 4 ID : 6306803564596

Status : Answered

Chosen Option : B

Marks : 1



Q.60 In a certain code language,

A + B means ‘A is the brother of B’,
A – B means ‘A is the father of B’,
A x B means ‘A is the mother of B’ and
A ÷ B means ‘ A is the wife of B’.

Based on the above, how is P related to T if ‘P x Q ÷ R – S + T’?

Ans A. Mother’s mother

B. Husband’s mother

C. Husband’s sister

D. Father’s sister

Question Type : MCQ

Question ID : 630680732903

Option 1 ID : 6306802872421

Option 2 ID : 6306802872423

Option 3 ID : 6306802872424

Option 4 ID : 6306802872422

Status : Not Answered

Chosen Option : --

Marks : 0

Q.61

Ans A. 24

B. 27

C. 34

D. 30

Question Type : MCQ

Question ID : 630680931655

Option 1 ID : 6306803651432

Option 2 ID : 6306803651435

Option 3 ID : 6306803651434

Option 4 ID : 6306803651433

Status : Not Answered

Chosen Option : --

Marks : 0

Q.62 There are 68 members in group A, 84 members in group B and 22 members in group C. All
the members of these groups went to a restaurant. The average amount spent on each
member of group A, B and C is ₹250, ₹339 and ₹187, respectively. The total average amount
(in ₹) spent per member is:

Ans A. 289

B. 287

C. 284

D. 285

Question Type : MCQ

Question ID : 630680984911

Option 1 ID : 6306803863763

Option 2 ID : 6306803863764

Option 3 ID : 6306803863762

Option 4 ID : 6306803863761

Status : Answered

Chosen Option : D

Marks : 1

Section : Numerical ability test



Q.63 33 men can do a piece of work in 40 days. The number of men required to complete the
same work in 6 days is:

Ans A. 221

B. 224

C. 219

D. 220

Question Type : MCQ

Question ID : 630680948009

Option 1 ID : 6306803716729

Option 2 ID : 6306803716730

Option 3 ID : 6306803716731

Option 4 ID : 6306803716728

Status : Answered

Chosen Option : D

Marks : 1

Q.64

Ans

A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 630680813154

Option 1 ID : 6306803186032

Option 2 ID : 6306803186031

Option 3 ID : 6306803186034

Option 4 ID : 6306803186033

Status : Not Answered

Chosen Option : --

Marks : 0

Q.65 If a and b are the roots of x2 - 28x + 11=0, then a quadratic equation whose roots are a2 and

b2 is:

Ans A. x2 - 762x - 121 = 0

B. x2 - 762x + 121 = 0

C. x2 + 762x + 121 = 0

D. x2 + 762x - 121 = 0

Question Type : MCQ

Question ID : 630680976036

Option 1 ID : 6306803828169

Option 2 ID : 6306803828168

Option 3 ID : 6306803828171

Option 4 ID : 6306803828170

Status : Not Answered

Chosen Option : --

Marks : 0



Q.66 The list price of a air conditioner is ₹30000. It is sold to a retailer after two successive
discounts of 4% and 5%. The retailer wants to earn a profit of 40% on his cost after allowing
a 50% discount (on its new list price) to the customer. At what price should he list the air
conditioner?

Ans A. ₹76718

B. ₹76608

C. ₹76527

D. ₹76477

Question Type : MCQ

Question ID : 630680995097

Option 1 ID : 6306803904417

Option 2 ID : 6306803904415

Option 3 ID : 6306803904418

Option 4 ID : 6306803904416

Status : Not Answered

Chosen Option : --

Marks : 0

Q.67 Amit invested a certain sum of money at 5% per annum simple interest. If he receives an
interest of ₹75807 after 10 years, the sum (in ₹) he invested is:

Ans A. 151539

B. 152271

C. 151614

D. 151435

Question Type : MCQ

Question ID : 630680808918

Option 1 ID : 6306803169254

Option 2 ID : 6306803169252

Option 3 ID : 6306803169251

Option 4 ID : 6306803169253

Status : Answered

Chosen Option : C

Marks : 1

Q.68 Kalpana and Sudha got 504 and 720 marks respectively in an examination. If Kalpana
scored 42% marks, then what is the percentage of marks scored by Sudha?

Ans A. 60%

B. 58%

C. 61%

D. 63%

Question Type : MCQ

Question ID : 6306801021547

Option 1 ID : 6306804009236

Option 2 ID : 6306804009238

Option 3 ID : 6306804009237

Option 4 ID : 6306804009239

Status : Answered

Chosen Option : A

Marks : 1



Q.69 Write the expanded form of (2a + 8b + 5c)2.

Ans A. 4a2 + 64b2 + 25c2 + 36ab + 80bc + 20ac

B. 4a2 + 64b2 + 25c2 + 32ab + 80bc + 20ac

C. 4a2 + 64b2 + 25c2 + 32ab + 75bc + 20ac

D. 4a2 + 64b2 + 25c2 + 32ab + 80bc + 30ac

Question Type : MCQ

Question ID : 630680827373

Option 1 ID : 6306803240828

Option 2 ID : 6306803240827

Option 3 ID : 6306803240830

Option 4 ID : 6306803240829

Status : Answered

Chosen Option : B

Marks : 1

Q.70 Simplify

Ans

A. 

B. 

C. 

D. 

Question Type : MCQ

Question ID : 630680704715

Option 1 ID : 6306802760548

Option 2 ID : 6306802760549

Option 3 ID : 6306802760547

Option 4 ID : 6306802760546

Status : Answered

Chosen Option : D

Marks : 1

Section : Basic Computer literacy



Q.71 Ramesh typed his physics, chemistry and biology marks in cells B1, C1 and D1. Identify the
formula he should use to calculate total marks.

Ans A. =B1 +C1 + D1

B. Total (B1, C1, D1)

C. B1+C1+D1

D. = “B1” + “C1” + “D1”

Question Type : MCQ

Question ID : 630680787966

Option 1 ID : 6306803087660

Option 2 ID : 6306803087663

Option 3 ID : 6306803087662

Option 4 ID : 6306803087661

Status : Answered

Chosen Option : B

Marks : -0.25

Q.72 How do you set the insertion point to a specific location in a document?

Ans A. Click the location with the mouse

B. Press Ctrl and click the location

C. Right-click the location

D. Double-click the location

Question Type : MCQ

Question ID : 630680795581

Option 1 ID : 6306803117325

Option 2 ID : 6306803117326

Option 3 ID : 6306803117324

Option 4 ID : 6306803117323

Status : Answered

Chosen Option : A

Marks : 1

Q.73 Which of the following is the correct way to use the SUM function in MS Excel to add the
values in cells A1 through A5?

Ans A. =SUM(A1)

B. =SUM(A1:A5)

C. =TOTAL(A1)

D. =ADD(A1)

Question Type : MCQ

Question ID : 6306801052152

Option 1 ID : 6306804130962

Option 2 ID : 6306804130961

Option 3 ID : 6306804130964

Option 4 ID : 6306804130963

Status : Answered

Chosen Option : B

Marks : 1



Q.74 Which of the following options allows you to customise the handouts by adding headers,
footers and page numbers before printing them in MS PowerPoint?

Ans A. Go to the 'Insert' tab -> Select 'Header & Footer' -> Choose 'Handout' to customize the
options

B. Go to the 'File' tab -> Select 'Print' -> Click on 'Handout Master' to customize the
handouts

C. Go to the 'View' tab -> Select 'Handout Master' -> Customize the layout -> Print

D. Go to the 'Design' tab -> Select 'Print Setup' -> Customize the handouts

Question Type : MCQ

Question ID : 6306801049591

Option 1 ID : 6306804120620

Option 2 ID : 6306804120621

Option 3 ID : 6306804120622

Option 4 ID : 6306804120623

Status : Not Answered

Chosen Option : --

Marks : 0

Q.75 Which of the following options in MS Word allows a user to preview how their document will
look when printed?

Ans A. File > Export

B. File > Save As

C. File > Print

D. File > Open
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Question ID : 6306801052572

Option 1 ID : 6306804132731

Option 2 ID : 6306804132730

Option 3 ID : 6306804132729

Option 4 ID : 6306804132728

Status : Answered

Chosen Option : C

Marks : 1

Q.76 In a Windows OS, which of the following features allows users to locate files and folders
across the system using natural language queries and filters such as date modified, file
type and size?

Ans A. Cortana

B. Command Prompt

C. Indexing Options

D. Search Box in File Explorer
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Option 2 ID : 6306804155685

Option 3 ID : 6306804155684
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Status : Answered

Chosen Option : D

Marks : 1



Q.77 Which of the following devices serves both as an input and an output device?

Ans A. Monitor

B. Keyboard

C. Touchscreen

D. Printer
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Option 1 ID : 6306804146791

Option 2 ID : 6306804146790
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Status : Answered

Chosen Option : C

Marks : 1

Q.78 Which of the following technologies is commonly used in high-end monitors to provide
better colour accuracy and viewing angles?

Ans A. Twisted Nematic (TN) Panels

B. Cathode Ray Tube (CRT) Displays

C. In-Plane Switching (IPS) Panels

D. Digital Light Processing (DLP) Technology
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Status : Not Answered

Chosen Option : --
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Q.79 Which of the following operating systems does NOT belong to desktops or laptops?

Ans A. Kali

B. Android

C. Ubuntu

D. Puppy

Question Type : MCQ

Question ID : 630680779300
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Status : Not Answered

Chosen Option : --
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Q.80 Which of the following options allows you to set the timing for how long a slide is displayed
before advancing to the next slide during a presentation in MS PowerPoint?

Ans A. Rehearse Timings

B. Slide Sorter

C. Slide Master

D. Slide Layout

Question Type : MCQ
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Status : Answered
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